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Word Concepts

Tables

Tables can be used to arrange
rows and columns of text and
numbers. Within each cell in the
table, text wraps around. When you
create a table, Word displays dotted
gridlines between the cells to show you the boundaries
of the rows and columns. These gridlines do not print
out. Use the border command to add gridlines which
print.

Creating a Table

Inserting a Table using the Toolbar

1. Position the insertion point where you want to
insert the table.

2. Click the Table button on the Toolbar. B |

3. Drag the mouse to select the number of
columns you want the new table to have.

=T AR

Zx 2 Table

4. Release the mouse button to insert the table.

To move to the next cell, press the Tab key. If you
want to move back to the previous cell, press Shift
Tab. Pressing Tab at the last cell of your table creates
a new row.

Notes :
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Formatting Tables

v The simplest way to format tables is to
choose Table Autoformat. Click into any table
and select Table Autoformat from the Table
Menu.

+ Table Properties are available by right
clicking a table cell and are also available
from the Table Menu.

v L Many features are also available
on the Tables and Borders Toolbar.
It is turned on and off with this icon .

Tables and Borders

o w L E - O
3 - d| =1 - 88 0 Al gl £ =
v Word offers an easy way to move tables by resting

the mouse on the top left corner a 4-pointed arrow
appears and can be used to relocate your table.

v Another option in Word is to insert a table
within a table

Notes :
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Word Concepts

Automating Your Work

There are several tools that can make working with

Word for Windows faster and more effective. These
include styles and templates.

A style is a group of
formats identified
by a style name.

Think of a style as

formatting command that

you design.

©

A template is a master copy for
all documents of a certain type.
A template can include the

text and graphics you want in
each document of that type. A template also sets

margins and other document formats, and it contains
styles.

Notes :
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AutoFormat & Styles

The AutoFormat command can quickly complete your
formatting, improve the document’s appearance, and
provide uniform formatting throughout a document.

Format AutoFormat

Word analyses each paragraph and determines how
the paragraph is used in the document , e.g. as a
heading, a footer, or normal text. Word then applies a
style, a built-in group of formats, appropriate for that
item.

After Word automatically formats a document, you can
review the formatting changes and styles, and you can
choose to accept, reject, or revise them.

You can always undo if you don't like it!

Notes :
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Styles

A style is a group of formats identified by a style
name. Think of a style as formatting command that
you design.

When writing a manual, report or letter you may want

to create a series of styles for headings and
paragraphs so that the document has continuity.

Using Styles
To apply a style
1. Select the text you want to format.

2. Select the style name in the Style box on the
formatting toolbar.

i A4 Heading 2 -

Redefining a Style
1. Select Format, Styles and Formatting
2. A window on the right will appear

3. Select Modify from the drop down

Styles and Formatting v

Formatting of selected text

Heading 2 4
[ Select Al & Instancels)
picl Clear Formatting
Mew Skyle, ..
Modify, ..

-A  Promote

< Demote

fj.‘;av Reveal Farmatting. ..
TRt Cefl T.2M

11 pt, Left: 2

©Libby Baker - IT Training libbybaker@xtra.co.nz Page 7



Word Concepts

4. Make the changes you require using the dialog
and the Format drop down in the bottom left

corner.
Modify Style X
Propetties

WE=E Heading 2

Styvle based on: 1] Heading 1

Skyle for following paragraph: 1 Mormal W
Formatting

Arial w| (12 |B| I 1u &-

= — — — = _ | = = | = —

== —-=--|izixs=

Using Styles

Heading 1 + Fant: 12 pt, Space Before: 18 pt, Mo page break before,
Keep with next, Level 2

[ ] Automatically update

o) ()

5. Always tick the Add to template box before
selecting OK.

Notes :
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Templates and Wizards

Templates hold formatting information for the documents you
create in Word. They enable you through the use of "styles"
and set formats to give your documents a consistent
appearance. There are several templates that come with
Word for creating newsletters, memos, faxes etc. A template
is given the file extension of .dot. When creating new
documents in Word for Windows the default template is
normal.dot.

A Wizard allows you to create a document by selecting your
own options related to the layout of the document.

v+ Select File New.

: Mew Document *

Mew
_] Elank document
] =ML document
@ Web page

MJ Fram existing document. ..

Templates
Search online for:

D}j Templates on Office Cnline
lﬂ_;J On my computer. ..
[ On ey Web sites, ..
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v Try clicking On my computer...
The following dialog will appear.

v Select any tab to view the templates and wizards
that come with Word.

Templates E|
Publications Reports Business Planner Template ... Business Planner Templates
General | Leqgal Pleadings Letters & Faxes Mail Merge Memos Other Documents
m =] |E=
— ; : Previgw
Blank. ¥ML Document  Web Page Cutline, dok
Ciocument
sampleresu, . Prewiaw not available.
Create Mew
(*)Document () Template
l Templates on Office Cnline [ [al'd ] l Zancel

Creating a Template
1. Format a document with text ,styles and field codes.
2. Select File Save.
3. Under Save as type select Document Template.

File name: |Manual| hd | [ Save l

Save as type: |D|:u:ument Templake (*.dak) w | Cancel

4. When saving note the folder location and extension
.dot

5. Choose File Close.

Notes :
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Create newsletter-style columns

Text in newsletter-style columns flows from one column to the next on the
same page.

1. Switch to print layout view.
2. Select the text you want to format in columns.

3. On the Standard toolbar, click Columns.

4. Drag to select the number of columns 4 &) T 1o

you want.

-
)
=X
c
2
=
i

Notes :
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Mail Merge

Word for Windows allows you to create form letters that can be
merged with a list of names and addresses. Merge printing can
save you time by printing off multiple form letters each individually
addressed. To create a form letter or mail merge document try the
following:

v Tools , Letters and Mailings, Mail Merge
+ A task pane will appear on the right of the screen

v Select document type

EMaiI Merge * W
S| ®|n

Select document type

What bype of document are you
warking on?

G} Letkers

) E-mail messages
) Envelopes

) Labels

() Directary

Letters

Send letters to a group of people.
‘ou can personalize the letker that
each person receives,

Click Mext to continue.

Step 1 0of 6
Next: Starting document
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Mail Merge

©|8| A

Select starting document

Haow do you wank ko sek up your
letters?
(%) Use the current document

() Start From a kemplate
() Start From existing document

Use the current document

Start Fram the document shown
here and use the Mail Merge wizard
ko add recipient information.

Step 2 of 6
Next: Select recipients

! Mail Merge
®|®| A

Select recipients
) Use an existing list
(%) Select From Outlook contacts
) Type a new list

Select from Outlook contacts

Select names and addresses From
an Qutlook contacts Folder,

& Choose Contacks Folder

i

Choose Contacts Folder

©Libby Baker - IT Training libbybaker@xtra.co.nz Page 13



Word Concepts

Mail Merge Recipients @

Ta sort the list, click the appropriate column heading, To narrow down the recipients displaved by a
specific criteria, such as by city, dlick the arrow next to the column heading. Use the check boxes or
buttons to add o remave recipients From kthe mail merge.
List of recipients:
w| Last | First | Title *| Comp... | Address | Citw ¥ Stabes
Saleman  Clive Robert ang...
Stevens  Lou Rhododend. ..
McClellan  Velma Research &... 10Morley St MePly...
Wallace  Shena Pukeoware ... 27 Sergean... RD4 ...
PIRINI Tania Puke Ariki
Day Kelvin Puke Ariki
RILEY Liza Puke Ariki
LAMBE... Ron Puke Ariki
Cerini Biobby Puke Ariki
ko Wayne Powerco
Esterh...  Johan Poweerco 2
[l Fiald AL EETNT Druscrem FTATT Mazn Macka
< >
[ Select Al ] [ Clear all ] [ Refresh ]

Step 3 of 6
Next: Write your letter

Mail Merge * x

Write your letter

If wou have not already done so,
write wour lekter now,

To add recipient information ko
vour letter, click a location in the
document, and then click one of
the items below,

= Address black...

= Gresting line. ..

_f| Electronic postage. ..
=] Mare items. ..

\When vou have finished writing
wour letker, click Mext, Then wou
can preview and personalize each
recipient's letter,

Each option can be used or go directly to More items...
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Insert Merge Field

Insert:

() Address Fields (#) Database Fields
Fields:
Firsk
Lask
Title
Company
Departrnent
Ciffice
Post Office Biox
Address
ity
Skate
ZipfPostal Code
Country
Phone
Mobile Phone
Pager Phone

3

[Matu:h Figlds. .. ] [ Insert ] [ Zancel

Step 4 of 6
Next: Preview your letters

! Mail Merge * x
& B A

Preview your letters

Cne of the merged letters is
previewed here, To preview
another letter, click one of the
Following:

Recipient: 1
% Find a recipient.. .

Make changes

%ou can also change vour recipient
(=

o Edit recipient list...

[ Exclude this recipient

\When vou have Finished
previewing vour letters, click Mext,
Then you can print the merged
letters or edit individual letters to
add personal comments,

Step 5 of 6
Next: Complete the merge

©Libby Baker - IT Training libbybaker@xtra.co.nz
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: Mail Merge *
®|®| A

Complete the merge
Mail Merge is ready to produce
waur letters,

To personalize wour letters, click
"Edit Individual Letters," This will
open a new document with vour
merged letters. To make changes
ko all the letters, switch back ko the
original document,

Merge

L33 Print...

& 7 Edit individual letters. ..

Step 6 of 6
+ An option is to use the Mail Merge toolbar

+ Right click on any tool bar and select Mail Merge

A|E = | 3 3 3| nsert word Field -
we H vn A KM 4! M

J\Lr
£
L
i
£
[
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Bullets & Numbering

Add bullets or numbering to existing text

1. Select the items you want to add bullets or numbering to.

Multi-level numbering

2. On the Formatting toolbar, click Bullets =

. i—
or Numbering i—.

1. From within the numbered list select Bullets and Numbering

from the Format Menu.

Bullets and Numbering

Bulleted | Mumbered — Cutline Mumbered l List Styles

=

1] 1.
a 1.1.
Mone :
i 1144
Article |, Headin 1 Heading 1 |. Heading 1
Section 1.01 H 1.1 Heading 2 A, Haading 2
(&) Heading = 1.1.1 Heading 2 1. Heading

Cusktomize. .,

Reset

[ o |

Zancel

2. Customize if necessary.

Smart Tags

il

Zonktinue Numbering

-

:=  Bullets and Mumnbering. ..

Notes :
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Headers & Footers

1. On the View menu, click Header and Footer to open the header
or footer area on a page.

2. To create a header, enter text or graphics in the header area.

Header and Footer

Insert AutoText ~ | & & e | & | EE & 5, | clos=

4. To create a footer, click Switch Between Header and Footer on
the Header and Footer toolbar to move to the footer area, and
then enter text or graphics.

5. If necessary, format text by using buttons on the Formatting
toolbar.

6. When you finish, click Close on the Header and Footer toolbar.

7. On the View menu, click Header and Footer.

8. On the Header and Footer toolbar, click Page Setup. LA
9. Click the Layout tab.
10.Select the Different first page check box, and then click OK.

11.If necessary, click Show Previous or Show Next PENSIS on the
Header and Footer toolbar to move into the First Page Header
area or First Page Footer area.

12.Create the header or footer for the first page of the document or
section.

13.If you don't want a header or footer on the first page, leave the
header and footer areas blank.

14.To move to the header or footer for the rest of the document or
section, click Show Next on the Header and Footer toolbar. Then
create the header or footer you want.

Notes :
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Graphics

Using Clipart

ol e DB ol | e = EY

1. Choose Insert Picture, Clipart.

2. Select the name and note the
preview window.

3. Choose OK or press enter.

The picture can be sized in
the document - using the
mouse. For accurate
positioning and word wrap.

Right mouse click to edit your picture.
Double-click and a new window will open. Double-click again
to customise.

Try Insert Picture WordArt or AutoShapes. Have fun!

Use this icon to turn on your Drawing Toolbar & .

It will appear at the bottom of your screen.

Notes :
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Hyperlinks & Linking other Office documents

v Type libbybaker@clear.net.nz and this email
address will automatically turn blue with an
underline.

v Try www.google.com and the same thing
happens for web sites.

v To create a hyperlink from an existing word right
click on the word and select Hyperlink.

Link, bo: Texk to display: |hyperlink ScreenTip...
Loak in: Manuals - =
Exjsting File or | _ |d J ﬂ @ E
‘Web Page Assessments P Bonkmartk, ..
CFH"l':nt word Practice Files
g ainer W ~4rd Intermediate latest, DoC Target Frame. ..
Place in This [ixﬂ ~WRLOODZ. brnp
Document Browsed IL-_E. 10 Tips For Working with Publisher 2002.doc
Pages E. Access - Analysing Data,doc
II.TE. Arcess - Design Process,doc
Create Hew Recent |"'_1 Circulat References . doc
Dacument Files '-‘_E. Excel - Data Analysis.doc
1) Excel 2000 overview.zip [V
Address: | ﬂ
E-mail Address
| Cancel
Hyperlinks can be:
1. An existing file or Web Page
2. A place in this document
3. A new document
4. An email address
Notes :
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Object Linking

Linking information from other documents is easy. The
mechanism that makes this integration possible is
known as Object Linking and Embedding.

Whenever you change the information in the source
application, it is updated within your document.

To Insert Linked Information into Word

1. Select the portion of the source document to be
linked. (An example might be a range of cells or
chart in Excel.) Choose Edit Copy.

2. Activate Word, and place the insertion point at
the position where you want to insert the
information.

3. Choose Edit Paste Special.

4. Select the desired data format in the dialogue
box and choose Paste Link.

5. To update the information, change it within the
source application. Word will automatically
make the same change to the data within your
document.

Notes :
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